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1. Downloading HOMER2 source and documentation 
 
http://www.nmr.mgh.harvard.edu/Optics/resources/homer2/home2.htm 
 
There you will find separate downloads for the source, Homer2_UI.zip or Homer2_UI.7z (compressed 
HOMER2 source using the open source tool 7-Zip), and executable, Homer2_UI.exe.  
 
 
2.  NIRS data format 
 
The most basic unit of a HOMER2 data set is a matlab file in the NIRS format that is the result of data 
acquisition. An example of a device that generates files in this format is the continuous wave techen device 
called cw6.  
 
The NIRS format has the following fields as a minimum requirement: 
 
t - This variable is the data time points array. It contains the data acquisition times. The dimensions of this array 
are <number of time points> by 1.  
 
d - This variable is the raw intensity time course. It is a 2D array where each element in row i, column j contains 
the raw intensity at time point i, in channel j. The dimensions of this array are <number of time points> by 
<number of measurement channels> 
 
SD - This is a structured variable containing the source/detector geometry. It has the following fields: 
 
    Lambda   -  Wavelengths used for data acquisition; dimensions <number of wavelengths> by 1            
 
    SrcPos     -  Array of probe coordinates of the lasers; dimensions <number of lasers> by 3 
 
    DetPos    -  Array of probe coordinates of the detectors; dimensions <number of detectors> by 3  
 
    nSrcs       -  Number of lasers; scalar variable 
 
    nDets      -  Number of detectors; scalar variable 
 
    MeasList  - List of source/detector/wavelength measurement channels.  It’s an array with  
                       dimensions, <number of  channels> by 4. The meaning of the 4 columns are as follows: 
 
                      Column 1  index of the source from the SD.SrcPos list. 
                      Column 2  index of the detector from the SD.DetPos list. 
                      Column 3 is unused right now and contains all ones. 
                      Column 4 index of the wavelength from SD.Lambda. 
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s   -   This variable specifies the time points and condition of stimulus onsets. Conditions are a way to separate 
stimuli into different groups, where each group is averaged independently of stimuli belonging to other 
conditions. Initially the values in s are binary; 1 at time point i designating stimulus onset,  0 designating no 
stimulus at time point i. Note: Values of 1 can be modified during a Homer2_UI session to be -1 or -2 
depending on how they are disabled. The dimensions of s are <number of time points> by <number of 
conditions>. 
 
ml - List of source-detector channels. This is a duplicate of the SD.MeasList above. 
 
aux - auxiliary signal of same dimensions as t. 
 
In addition to the above parameters, additional parameters can appear in the NIRS file as a result of processing 
the data set in Homer2_UI (see section 6.6).  
 
 
3. HOMER2 directory structure and data file organization 
 
Any directory that contains one or more files with the .nirs extension is considered by Homer2_UI to be a 
HOMER2 data set called a group.  The group of .nirs files is also organized into sub-groups called subjects. 
Each .nirs file in the group is in the NIRS format described above and logically belongs to a subject. The name 
of each .nirs file determines to which subject it belongs. By organizing files in this way, it is possible to 
calculate and view the hemodynamic response to different stimuli averaged at the run level, at the subject level, 
and at the group level. 
 
In order to have two or more .nirs files treated by Homer2_UI as members of the same subject, the files have to 
be named using the following convention: 
 
<subjectName1>_run01.nirs 
<subjectName1>_run02.nirs 
. . . . . . . . . . . . .  
<subjectName1>_run<n1>.nirs 
<subjectName2>_run01.nirs 
<subjectName2>_run02.nirs 
. . . . . . . . . . . . .  
<subjectName2>_run<n2>.nirs 
. . . . . . . . . . . . .  
<subjectNamem>_run01.nirs 
<subjectNamem>_run02.nirs 
. . . . . . . . . . . . .  
<subjectNamem>_run<nm>.nirs 
  
 
This above shows the naming convention of the general group consisting of m subjects with each subject 
containing n1, n2, …, nm runs respectively.  
 
For example, the group  
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241-20101020_run01.nirs 
241-20101020_run02.nirs 
241-20101020_run03.nirs 
242-20101021_run01.nirs 
242-20101021_run02.nirs 
242-20101021_run03.nirs 
242-20101021_run04.nirs 
265-20101213_run01.nirs 
265-20101213_run02.nirs 
269-20101229_run01.nirs 
269-20101229_run02.nirs 
 
consists of the 4 subjects, 241-20101020, 242-20101021, 265-20101213 and 269-20101229, with 3, 4, 2 and 2 
runs respectively, totaling 11 files. 
 
NOTE: It is not necessary to name .nirs files according to the above convention if you don’t care about 
associating multiple runs with each subject. If the .nirs file names do not contain run information in the naming 
format described above, then by default each file will be treated as the first and only run of a separate subject in 
the group. 
 
 
 
4. GUI overview 
 
4.1 Running  Homer2_UI GUI  
 
The Main GUI is called Homer2_UI. It contains the probe geometry window, data window, and the list of .nirs 
files comprising the HOMER2 data set. To run the GUI in matlab use the function Homer2_UI.m with no 
arguments. 
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4.1.1 Probe window 
 
The Probe Window displays the probe geometry. Letters designate sources, and numbers designate detectors. 
Lines between them represent the source/detector measurement channels that are specified in the ml variable 
from the .nirs file. 
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To display one or more channels’ data in the data window, click near a source or detector in the probe window. 
Clicking near a source will display data for all channels associated with that source. The same holds for clicking 
near a detector. Below is an example of Homer2_UI GUI with the first 3 measurement channels selected, 
displaying their raw data: 
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4.1.1.1   Making channel data invisible 
 
Typically, time courses for several channels are displayed simultaneously in the Data Window, since an optode 
usually has more than one channel associated with it. It is often useful to display only one time course at time, 
especially if the time courses are close together and obscure each other. This can be done by un-displaying the 
channels one doesn’t want to see. To un-display a channel’s data left-click the mouse over channels in the 
Probe Window.  This will un-display the data associated with that channel. 
 
 
4.1.2  File window 
 
The File Window displays the list of files in the group data set of the current Homer2_UI session. In this case 
the group contains 2 subjects called A and B with 3 and 2 runs (.nirs files) respectively. The data of subject B’s 
second run is being displayed in this particular example. 
 
 

 
 
 
4.1.3 Data Window and Plot Panel 
 
The Data Window displays the data for the channels selected in the Probe Window for the file selected in the 
file window.  
 
The specific data displayed in the Data Window is determined by the selections in the Plot panel. But generally 
speaking, it can be any of the following:  
 
a) raw data: for a selected wavelength 
b) optical density: for a selected wavelength 
c) hemoglobin concentration: HbO, HbR  HbT 
d) HRF for run, subject, or group: HbO, HbR, HbT 
 
Depending on the data type selected, you can choose which wavelength or concentration to be displayed. It is 
possible to select more than one wavelength or channel to display by selecting the second choice with the right 
mouse button. 
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When a new data set is loaded  (which has not yet been processed by HOMER2 ), the OD, Conc, HRF 
checkboxes and Plot Probe checkbox are disabled because those buttons are associated with data that is 
calculated from the raw signal. In this case the data displayed in the data window – after clicking on one of the 
channels in the probe window - is the raw signal by default. 
 
 
 
4.1.4 Processing options for group HRF: Group Average Panel 
 
TBD 
 
4.1.5 Zoom, Pan, Etc. Panel 
 
This panel allows the user to magnify and pan the data displayed in the Data Window. It also enables the user to 
manually exclude data time points which look to have motion artifacts and  to toggle stimuli on or off. For more 
details, see section 6.1 
 

 
 
 
 
4.2 Processing stream options GUI 
 
Clicking the Options button in Homer2_UI GUI will bring up the ProcessOpt GUI. 
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The ProcessOpt GUI displays the configurable collection of functions (or processing stream) that processes the 
raw signal to calculate the evoked hemodynamic responses to presented stimuli. These functions typically 
include motion correction, calculate the optical density changes, band-pass filtering, calculate the hemoglobin 
concentration changes, and calculating the hemodynamic response function (HRF).  
 
The exact calculation depends on the particular set of functions in the processing stream and the parameter 
settings – editable in the ProcessOpt GUI - associated with those functions. 
 

 
 
The figure above shows a processing stream composed of 7 functions, beginning with a conversion from raw 
data to optical density and ending with a function that calculates the HRF from the hemoglobin concentration 
changes and given the stimulus marks that were not excluded by the stimulus rejection function (4th function 
from the top).  
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More information about the functions that can appear in the processing stream and their associated parameters 
can be found in the function reference section (see sections 7.2 and 8 below). 
 
 
4.3 Stimuli GUI  
 
The stimGUI allows the user to create, delete and modify the stimulus marks used to determine which time 
points are used to calculate the HRF.  
 
To start stimGUI, select the stimGUI option from the Tools menu of Homer2_UI.  
 
Besides displaying the stimulus marks, the Stim Window also displays the specified auxiliary signal as a black 
line. The panel “Add StimMarks using Aux” allows the user to use a simultaneously recorded aux signal to set 
stim marks automatically.  
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New stimulus marks can be added by mouse clicking in an area of the Stim Window that has no stimulus mark. 
Stimulus marks can be deleted or modified by selecting (dragging the mouse cursor) over existing stimulus 
marks in the Stim Window. Another way to do the same thing is to enter specific time points – if known - in the 
edit box of the “Add/Delete/Edit Stim Marks”. For details, see section 6.4. 
 
Lastly, stimulus conditions can be further differentiated by utilizing the User Data Table. This table has a row of 
edit windows for each stimulus mark and a column for each user defined variable. The user can add more 
columns for each new variable. For details, see section 7.2.1. This table is useful, for example, to provide 
behavioral information related to each stimulus that can subsequently be used to select trials that meet specific 
criteria when estimating the HRF. 
 
 
4.4 Plot Probe GUI 
 
The plotProbe GUI allows the user to view the HRF in probe space after data has been processed.  
 

 
 
 
It has a controls panel at the bottom of the GUI which allows the user to  
 
a) scale the data  
b) view time markers starting with stimulus onset 
c) view amplitude by setting the size of the time markers and viewing them relative to the data.  
d) view pruned channel data which is ordinarily hidden 
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e) Duplicate current plotProbe GUI in separate figure. 
 
For more details, see section 10. 
 
 
 
5. Getting Started 
 
5.1 Loading a data set into Homer2_UI 
 
When Homer2_UI first launches, it asks the user to select the folder containing the data set to be analyzed. 
 

 
 
 
5.2 Choosing a processing stream configuration file 
 
After choosing the folder containing the data set, the user is asked to choose a processing stream configuration 
file in the Load Process Options File window. If the data set has already been processed in Homer2_UI, then the 
user is not asked to select the configuration file since it has been selected previously.  
 
A processing stream configuration file specifies the set of functions that will be executed on the data, starting 
with the raw data and ending with a processing result such as HRF. Typically the end result will be the HRF, 
although it doesn’t have  to be. 
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If the user doesn’t have a configuration file to load, a default one can be created by clicking the Cancel button in 
the Load Process Options File window. 
 
Also the user can edit the current processing stream or create one from scratch by using the procStreamGUI 
which is accessed from the Tools menu in Homer2_UI GUI. For details see Appendix A. 
 
 
5.4 Loading a new data set in an existing Homer2_UI session 
 
To load another data set in an existing Homer2_UI session, go to the File Menu and choose Change Directory. 
Subsequent processing will be done on this data set and will have no impact on the previous data set. 
Furthermore, if this new data set has not yet been processed, then the user will be asked to select the processing 
stream configuration file. Otherwise, the processing stream configuration will be the same as when previously 
analyzed. The processing stream configuration for the new data set will not be impacted by the previous data 
set. 
 
If the user wishes to utilize the same processing stream configuration for the new data set, then the user should 
export the configuration from the previous data set, and then load them into the new data set using the 
commands in the file menu. 
 
 
5.5. Viewing data before processing  
 
Click on one of the source-detector channels in the Probe Window to view the Raw Data.  
 
 
5.6 Undoing (resetting) changes to data set 
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Data that has been processed in Homer2_UI is saved automatically to disk. Run data is saved in the 
corresponding .nirs, while subject and group processing results are save to groupResults.mat 
 
To go back to the state before any processing was done to the data set, go to the File Menu and choose Reset 
File. The user will be given a choice whether to reset only the currently selected .nirs file or the whole data set.  
 

 
 
The .nirs file(s) selected for reset will be returned to their original state. If All Files is selected, then 
groupResult.mat will be deleted in addition to all .nirs files being reset 
 
This feature may be useful if the user wants to move .nirs files to a different data set and doesn’t want the 
previous data to be displayed with the new data set. It is also useful for developers of HOMER2 to be able to 
return .nirs files to their original states. 
 
 
6. Configuring data prior to processing 
 
Before processing the raw data, the user can set many options which determine exactly which data is included or 
excluded in the processing, which will ultimately determine the processing result. The following two sections 
describe the major configurable options that can be set prior to processing. 
 
6.1 Zooming , panning data displayed in Data Window 
 
Use the Zoom, Pan, Etc panel in Homer2_UI to zoom in and pan the magnified data, by clicking the Zoom radio 
button and then dragging the mouse over the data in the Data Window you want to magnify. To pan the zoomed 
data, click on the left or right arrow buttons in the Zoom, Pan, Etc panel. You can zoom out by right clicking the 
Data Window. 
 
To reset the data display to the entire (original) time course, click on the Zoom Reset button in the Zoom, 
Pan, Etc panel. 
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Figure 6.1:      a) selecting section of data to be magnified                                            b) magnified section of data 

 
To pan zoomed data click on the left or right arrow buttons in the Zoom, Pan, Etc panel.  
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                                          Figure6.2:  Panning data 

 
 
 
6.2 Manually excluding data 
 
Excluding data manually means marking the time points where data is deemed to be invalid. While this by itself 
will not shorten the time course in the calculation of OD or Concentration, any stim marks contained within the 
marked time points will not be included in the HRF calculation.  
 
Data can be determined to be invalid if the signal changes are due to a factor other than hemodynamic response 
to brain activity or physiology, such as motion of the subject. This can be done just by visually examining the 
raw signal in the data window.  
 
To manually exclude portions of data from being processed, first click the Exclude Time radio button in Zoom, 
Pan, Etc panel;  
 

 
 
then drag the cursor in the data window across the time points that contain the unwanted data, as shown in the 
figure below. 
 

 18



 

 
 

 
You should see a purple patch like the one shown below. Any stimulus marks within this temporal range will 
become dashed to indicate that this stimulus mark has been toggled off and will thus not be included in the HRF 
calculation. A purple patch can be deleted by simply mouse clicking on the purple patch and selecting the 
correct option in the pop-up window. 
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6.3 Excluding stimulus marks 
 
In addition to excluding data, stimulus marks can be excluded or deleted directly. To exclude a stimulus mark, 
click the Stim Reject radio button in the Zoom, Pan, Etc panel of the main GUI 
 
 

 
 
Then drag the mouse over the stimulus mark or marks that you want to exclude. The example below shows the 
last stim in the time course being excluded. This does not delete the stimulus mark but only makes it dashed to 
indicate that it has been manually removed. 
 

 
 
 
6.4 Adding, Deleting and Editing stim marks  
 
To permanently delete, add or modify a stimulus mark open the stimGUI from the Homer2_UI Tools Menu.  
 
6.4.1 Deleting and modifying existing stimulus marks 
 
To delete a stimulus mark, select it by dragging the mouse over it in the Stim Window and click the Delete 
button in the pop-up window.  
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Groups of stimulus marks can be differentiated using different condition labels. These condition labels are 
subsequently used when calculating the HRF for the different stimulus conditions. The user can change the 
condition label of a stimulus mark from the stimGUI by dragging the mouse over the stimulus marks in the Stim 
Window and then creating a new condition or selecting an existing one.  
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Since there’s only one existing condition, you need to create a new condition label to differentiate the selected 
stimulus marks.  
 
 

       
 
 
6.4.2 Adding new stimulus marks 
 
In the previous section, after deleting one stimulus mark and editing two, the stimGUI looks like the figure 
below:  
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We can add a new stimulus mark by clicking the mouse (without dragging) in the Stim Window at the time point 
where you want to place the new stimulus mark and where there’s no existing stimulus mark.   
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6.4.3 Saving changes in the stimGUI 
 
NOTE: If you exit stimGUI without saving the changes they will disappear. To have any changes take effect 
click on the Save button as shown below. The changes will then be saved in the .nirs file and appear in the main 
GUI.  
 

 
 
 
6.4.4 User Data Table 
 
Stimulus marks belonging to the same condition can be further differentiated using the User Data Table. Any 
type of numerical information can be recorded in this data table and associated with each stimulus mark. This is 
particularly useful for recording any behavioral data associated with each individual stimulus. These data can be 
utilized in the processing stream to decide which stimuli trials are included in the estimation of the HRF and 
which stimuli trials are excluded.  
 
The user data table has a row of edit windows for each stimulus mark and a column for each user variable. The 
user can add more columns for each new variable.  
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Here’s an example of one such variable: baby subjects are given a visual stimuli which slowly moves across 
their field of vision for about 5 seconds. Once the data is acquired it might be desirable to estimate the HRF 
using only stimulus trials for which the infant actually looked at the object greater than a certain amount of time 
(e.g. 2 seconds). In this example there are 6 stimulus trials (see figure below) belonging to the visual condition 
and 2 stimulus trials belonging to another condition. The experimentally determined looking times for the visual 
condition (i.e. red stimulus marks) are 3, 1.4, 2.1, 1, 4.3, and 2.5 seconds respectively. 
 
First name the column in the user table by left clicking over the column.  A window comes up which allows a 
name to be entered: 
 

 
 
 
The user data table would then be used to enter the looking time of every stimulus mark. Note that in this case, 
data is not entered for trials for which the variable ‘looking time’ is not relevant. 
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Now to average only those stimulus trials with ‘looking time’ greater than 2 seconds,  
 
a) Bring up processing stream options from the Homer2_UI.  

 
b) Find the function Stim_Exclude_UserDefVars and enter a range of 2 to 10.  
 
c) Recalculate the HRF for the run by choosing ‘Run’ from the Calculate HRF  dropdown menu.  
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You will notice after the average is calculated that stimuli with looking time less than 2 seconds will be 
excluded from the HRF calculation and will become dot-dashed lines. 
 
 
6.5 Manually pruning noisy or otherwise bad channels 
 
To prune a channel means to exclude a channel’s data from calculations for that run. If a channel is deemed bad 
- for instance, say in the example below channel A-3 is too noisy - it can be excluded by  
 
 
a) making the channel’s data visible in the data display by clicking on a source or detector associated with that 
channel in the Probe Window.  
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b) then left clicking the mouse over that channel. It’s background color will then change to pink and the 
foreground will become dashed.  
 

 
              Figure 1 

 
To undo the exclusion simply left click again on the channel. 
 
 
6.6 Additional parameters saved to .nirs files 
 
In addition to the initial parameters which define the .nirs data format - SD, d, t, s, ml, and aux - other 
parameters might be saved to the .nirs files as a result of manual configuration discussed in this section and the 
processing discussed in section 9.  
 
Here we will just talk about the parameters that can be saved when manually configuring data.  
 
As a result of manual configurations above, the following additional parameters will appear in a .nirs file: 
 
           tIncMan             :  Manual time exclusion 
 
          SD.MeasListAct :  Manual channel pruning 
 
          CondNames        : a list of condition names used for the stimulus marks 
 
          s0                        :  The s matrix is modified as a result of stimulus mark exclusion, deletion or 

     addition of new stimulus marks. If the s matrix is changed in any way, the original  
     s matrix is saved in s0.  
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          userdata              :   Contains the information entered into the user data table in the 

         stimGUI.  
 
          procInput            :  See section 9.1 for details 
 
          procResult          :  See section 9.1 for details 
 
 
7. Setting processing stream parameters  
 
In addition to setting and editing stimulus marks, probe channels, and excluding or including raw data, the user 
can also edit the parameter options in the processing stream.  
 
The ProcessOpt GUI (introduced in section 4.2) is the user interface to the processing stream. It is divided into 
rows by gray line dividers, each of which contains a processing stream function.  
 
Each function contains 4 columns:  
 
column 1 – function name  
column 2 – parameters associated with the function  
column 3 – edit boxes where the parameter values can be set/modified 
column 4 – results button (help) 
 
The example below shows a simple processing stream consisting of 3 functions: a) hmrIntensity2OD - converts 
raw data to optical density; b) hmrBandpassFilter - band-pass filters optical density; c) hmrOD2Conc converts 
optical density to hemoglobin concentration.  
 

 
 
Passing the mouse slowly over the function or the parameter names will bring up a brief explanation from the 
help registry.  
 

 29



 
 
By adding one more function - hmrBlockAvg -  to the processing stream (see section 9: Creating your own 
processing stream), one can obtain the hemodynamic response to the presented stimuli.  
 
7.1 Some basic processing stream functions 
 
Here is a ProcessOpt GUI with some of the basic processing stream functions followed by their descriptions: 
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a) Conversion of Raw data to Optical Density 
hmrIntensity2OD.m: 
 
TBD 
 
b) Filtering  
hmrBandpassFilt.m: Function band-pass filters noisy data or .... 
 
c) Identifying motion artifacts  
hmrMotionArtifact.m:  
 
This function identifies motion artifacts in the raw data. Data time points that are determined to be a motion 
artifact are marked with a pink patch in the Data Window of Homer2_UI..  
 
Note: this function has to be used in conjunction with enStimRejection (or any user-defined stim rejection 
function) in order for the motion artifact identification to have an affect. 
 
d) Stim exclusion based on motion artifacts 
enStimRejection.m:  
 
This function checks whether any stims are within rejection distance of any of the identifed motion artifacts in 
the time course data.  
 
e) PCA filtering 
enPCAFilter.m: 
 
TBD 
 
f) Automatic channel pruning  
enPruneChannels.m: 
 
TBD 
g) Conversion of Optical Density to Hb concentration 
hmrOD2Conc.m: 
 
TBD 
 
h) Calculating average stim response (HRF) 
hmrBlockAvg.m: 
 
TBD 
 
7.2 Meaning of Copy Options checkbox 
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The copyOptions checkbox determines whether the processing stream parameter values apply only to the 
currently selected file when processing occurs or to all files in the group.  
 
If the checkbox is checked then the current values will be copied to all files being processed. If the checkbox is 
unchecked, the editing will not affect any other file's parameter settings, and will therefore apply only to the 
selected file.  
 
 
 
 
 
 
8. Processing data 
 
To process the data, you must execute the processing stream. The user has the option of applying the processing 
stream to just the run selected in the File Window, all the runs belonging to the subject whose run is selected, or 
all the subjects in the group – that is, all the files in the File Window.  
 
If the processing stream estimates the hemodynamic response to stimuli, then averaging over the stimuli will be 
performed on all the files for the subject for session calculations. Similarly for group calculations, averaging 
will first be performed for a subject, and then across subjects. 
 
To process data, select one of the options in the dropdown menu Calculate HRF.  
 

 
 
 
The double stars next to the Calculate HRF option means that for the selected file, either processing hasn’t been 
done and therefore there’s no processing result or the processing stream option values have been altered. The 
stars disappear if a processing result has been calculated for the current processing stream options. 
 
To process data for a single run, select the Run option from the Calculate HRF dropdown menu. 
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In this case, processing will be done only for the second run of subject A, that is A_run02.nirs.  
 
To process data for a single subject/session, select the Session option from the Calculate HRF dropdown menu. 
 

  
 
 
In this case, processing will be done only for all 3 runs in subject A, that is,  
 
A_run01.nirs  
A_run02.nirs 
A_run03.nirs 
 
To process data for the whole group, select the Group option from the Calculate HRF dropdown menu. Note: 
For a group calculation the selection in the File Window doesn’t matter since all the files are members of the 
current group.  
 

 
 
 
In this case, processing will be done for all the files in this group, that is  
 
A_run01.nirs 
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A_run02.nirs 
A_run03.nirs 
B_run01.nirs 
B_run03.nirs 
 
 
8.1 Additional data processing variables saved to .nirs files 
 
The following additional parameters will be saved in the .nirs files as a result of data processing: 
 
procInput     :    This variable contains the processing stream functions, their parameters and  
                          values used to process data. 
 
procResult   :   Contains the results of processing including optical density, concentration,  
                         optical density and concentration averages, and any other variables that are the  
                         result of executing the processing stream 
 
 
 
 
 
9. Viewing Processed and Unprocessed Data 
 
The combination of button setting in the plot panel determines what data is displayed in the Data Window.  
 
9.1  Raw Data 
 
Raw data is displayed by clicking the Raw Data radio button and selecting one or both of the wavelengths in the 
center listbox. In the example below, raw data is displayed at 690nm. 
 

 
 
 
 
9.2 Optical Density  
 
Optical density is displayed by clicking the OD radio button and selecting one or both of the wavelengths in the 
center listbox. In the example below, optical density is displayed at 830nm.  
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To view time courses for both wavelengths, right-click on one and then the other wavelength in the listbox 
while holding down the shift key. 
 
 
9.3 Hemoglobin Concentration 
 
Hemoglobin concentration is displayed by  
 
a) clicking the Conc radio button  
b) selecting one, two or three of the Hb types from the listbox in the center. To view time courses for more than 

one Hb type, right-click on the listbox selections while holding down the shift key. 
 
In the example below, HbO and HbT concentrations are displayed. 
 

 
 
 
 
9.4 Hemodynamic response function (HRF)  
 
The HRF is displayed by selecting  
 
a) Conc radio button (OD can be selected as well if the HRF was also calculated for OD in the processing 

stream), 
b) one, two or three of the Hb types from the listbox in the center,  
c) one of the conditions in the dropdown menu,  
d) check one of 3 show* HRF checkboxes on the right.  
 
In the example below, the subject HRF is displayed for Deoxy-Hemoglobin,  for condition Label A.  
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9.4.1 Viewing HRF standard error 
 
To view the standard error for HRF in the Display Window, click on the View HRF Std Error in the View menu 
 

 
 
 
9.5 Displaying HRF for the whole probe: Plot Probe 
 
T o display HRF for the whole probe  
 
a) select the Conc radio button 
b) select the stim condition from the dropdown menu, 
c) select one, two or three of the Hb types from the listbox in the center,  
d) click one of the 3 show * HRF checkboxes on the right,  
e) check the Plot Probe checkbox. 
 
 

                              
 
 
 
Here’s what the Plot Probe window looks like: 
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9.6 Example: stepping through all data types 
 
In the example below, the raw data at 690nm is displayed for channels D-3 and D-6 of file SubjectH_run1.nirs 
 
                                                    

            
Figure 9.1:       a)                                     b)                                                                 c)  

 
The data displayed in the Data Window is determined by the selections shown above in the Figure 9.1: a) File 
Window, b) Probe Window , and c) Plot Panel. In this case the displayed data is raw data at 690nm, for channels 
C-4 and C-6 for run B_run01.nirs. 
                                                                        
 The resulting data display for the above selections: 
   
 

   
 
                 
Keeping the File and Probe Window selections constant, we change only the Plot panel selections to display the 
other data types: 
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Viewing raw data at either wavelength: 

 
 

      
                                         R aw data at 830nm time course 

 
 
Viewing optical density both wavelengths: 
 
 

   
                                            Optical Density displayed simultaneously at 690 and 830 nm 

 
 
 
Viewing HbO, HbR simultaneously: 
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             Oxy and De-oxy hemoglobin concentrations. displayed simultaneously 

 
 
 
 
 
 
Viewing HbO and HbR HRF for condition 1 in Figure 9.2, we see the level of HbO sharply rises after stimulus 
onset and then fall toward the end of the HRF time course. Within the same time period the level of HbR falls 
not as sharply and then rises toward the end of the time period. This type of response pattern is indicative of 
activation.   
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 Figure 9.2: a) Run HRF for channels A1 and C1                                 b) Group HRF for channels  A1and C1 

 
To view the HRF for the whole probe, check the Plot Probe checkbox in the Plot Panel. Figure 9.2 below 
shows the group HRF for the whole probe.  

 

                                          
                                          Figure 9.2 
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10. Plot Probe 
 
The plotProbe GUI displays the HRF in probe space for the selected file, condition and HRF type. The control 
panel has several features allowing the user to determine how the data is displayed.  
 
10.1 Scaling data  
 
TBD 
 
10.2 Viewing time markers and amplitude 
 
TBD  
 
10.3 Viewing amplitude  
 
TBD 
 
10.4 Viewing pruned channel data  
 
TBD 
 
11. Determining and localizing activation 
 
To determine if a block average shows a hemodynamic response to brain activation, we look for a particular 
pattern – the more similar to this pattern the stronger the brain activation.  
 
A typical pattern that is indicative of brain activation for a particular channel is the following: HbO 
concentration gradually rises after stimulus onset and then gradually falls to pre-stimulus levels, while HbR 
concentration does the opposite; gradually falls after stimulus onset and then gradually rises back to pre-
stimulus level.  
 
In addition, usually the duration of the response for HbO and HbR is very similar. A typical example is Figure 
49 from section 10.6, reproduced below 
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       Figure 11.1:    a)  probe geometry                                   b)  plotProbe  display of  HRF in the probe space 
 
 
This plotProbe GUI in Figure 11.1 shows the strongest activation in channels S3-D1 , S1-D1 and to a lesser 
extent. S2-D1. In the Probe Window (Figure 50a) these channels correspond to C1, A1, and B1 respectively. 
The data for the rest of the channels either don’t exibit the pattern or are much weaker responces. 
 
 
 
12. Examples 
 
This section shows several fully worked out examples on sample data sets. The data sets can be downloaded 
from the HOMER2 web page (there an option of 2 different fomats)  
 
http://www.nmr.mgh.harvard.edu/optics/resources/homer2/SampleData.zip 
http://www.nmr.mgh.harvard.edu/optics/resources/homer2/SampleData.7z 
 
The following examples assume Homer2_UI and SampleData was downloaded to the Desktop. But should work 
the same from any directory. To start, click on the Homer2_UI icon on the desktop 
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12.1 Simple Probe 
 
This example illustrates how to obtain average response from a single run with a simple 4 channel probe and 3 
trials and to filter out noise from the average responce 
 
1. After clicking on the Homer2_UI icon, you’ll be asked to select one of the sample data set directories. Click 

on Example1_Simple_Probe.  
 

 
 
 
 
2. Choose the config file processOpt_ex1.cfg 
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3. To process the data choose Run from the Calculate HRF dropdown menu.  
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4. View Concentration for only one channel (A3) by  
 
a) right clicking over channels A1,A2 and A4 and  
b) clicking on the Conc radio button. 
 
You should now see a probe and data window that looks like this: 
 

          
 
 
 
 
5. View HRF by clicking on the show Run HRF checkbox in the Plot Panel 
 
 
   

 
 
 
6. Click the Options in Homer2_UI to look at the processing stream that was used to calculate the above Hb 
concentration and HRF results.  
 
It shows that the HRF time range that was averaged using the function hmrBlockAvg is 2 seconds before and 20 
seconds after strimulus onset. Also it shows that the Hb concentration and HRF data above are noisy because 
the frequency of the noise is higher than 3Hz.  
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7. To get rid of the noise lower the value of the low-pass filter parameter (lpf) for the bandpass filter function 
(hmrBandpassFilt) in the processing stream. To do this  
 
a) click the Options button in Homer2_UI 
b) find hmrBandpassFilt function and its user parameters, hpf and lpf. Since the frequency of the noise is 

smaller than 3hz, try lowering the lpf to 1 or .5 hz.  
c) Select Run from Calculate HRF dropdown menu to recalculate the HRF with the new lpf setting  
You should see a smoother signal for Hb Concentration and HRF 
 

 

              
 
 
12.2 Single subject finger tapping data, 
 
TBD 
 
12.3 Multi-subject, multi-run finger tapping data 
 
TBD 
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Appendix A:  Creating your own processing stream (for advanced users) 
 
If a user is familiar with the processing stream functions, and have specific data processing needs that vary from 
the basic default configuration, a custom processing stream can be built from the complete list of functions 
listed in the Process Stream GUI.  
 
To start the Process Stream GUI, go into the Tools Menu and select Process Stream GUI. 
 

 
 
The GUI has 3 sections as seen above: File Registry Window, Processing Stream Window, and Help Window. 
The Function Registry and Processing Stream windows each have 3 columns:  
 
left column       -  contains the function’s output parameters,  
middle column  - contains the function name,  
right column      - contains the input arguments.  
 
You can familiarize yourself with the available functions by browsing the list in the Function Registry  Window 
on the upper left section and reading the function description in the Help window.   
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A.1 Building a processing stream 
 
Here's an example of building a very simple 3-function processing stream which  
 
a) converts raw data to optical density; 
b) converts the filtered optical density to Hb concentration; 
c) and finally calculates the average responce 
 
The 3 functions from the Function Registry Window we would choose for this processing are  
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a) hmrIntensity2OD  
b) hmrOD2Conc 
c) hmrBlockAvg 
 
Note that a function can have multiple versions - the one you use will depend on the type of data you are 
processing. In this example, there are 3 versions of hmrBlockAvg in the File Registry.  
 
To build this processing stream select each of the 3 functions above from the File Registry.and click the Add 
button. 
 
The order can be changed by selecting a function in the Processing Stream Window and clicking the Up or 
Down button to move the function one space up or down in the processing stream list.  
 
When you have the desired configuration, click the Save button to save this stream to a config file. 
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A.2 Loading and editing a processing stream 
 
To load a processing stream into the Process Stream GUI, click the Load button and choose a processing stream 
config file. It will appear in the Processing Stream Window on the right. Now you can add, delete or move 
functions in the loaded processing stream. When done, click the Save button to save the new configuration to a 
file. 
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